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This document lists the main changes and fixes compared to the Magics 26.1 release.  

 

1 What’s new – working with scenes 

Since Magics 26, there are two main scene concepts: 

1. part scenes (which include both mesh and BREP) are used for preparing, fixing and 
editing individual parts 

2. platform scenes (currently only mesh) used for build preparation. Within the platform 
scene context, a new ‘edit mode’ has been introduced, next to the existing ‘SG mode’. 

1.1 Edit mode  

This mode is designed to allow for limited editing and fixing of multiple parts or virtual copies 
within the platform context, while the ‘Edit in Part Scene’ (former ‘Edit Part’) operation remains 
available for in-depth data preparation focused on a single master part or assembly in a part 
scene with a full set of tools. 

 

Edit in Part Scene versus Edit Mode 

 

1.2 ‘Edit in Part Scene’ (former Edit Part) enhancements 

Orientation preservation 

‘Edit in Part Scene’ command will now keep the part’s platform orientation when launching the 
part scene. 

Note: Orientation is only preserved once upon part scene creation. Any further change of orientation in 
the part scene itself is not supposed to be reflected back to the platform.  

Virtual copies handling 

For part(s) with multiple virtual copies on the same or different platform(s), the user will be 
asked about preferred way to handle virtual copies after launching ‘Edit in Part Scene’ 
command. If the intention is to edit all copies in one go, the user will enter part scene with 
existing master part. However, if only selected virtual copies should be affected, the new 
master part will be created for them and thus the link with other copies will be broken. 
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Unloading parts from Mesh Part Scene 

When unloading parts that have virtual copies Magics allows to either unload them from the 
part scene only or from all scenes in one go by giving the warning message to the user: 

 

Groups can be preserved when opening them in Part Scene  

In the Platform scene of Magics, when one or more parts are grouped together and the "Edit 
in Part Scene" command is clicked, the entire group is added to the same Part scene as 
grouped parts. It is worth noting that if virtual copies are present in the grouped part, they will 
automatically be split into unique parts upon executing the "Edit in Part Scene" command while 
still part of the group. 

1.3 General improvements on working with scenes and parts 

Scene naming 

Naming improvements have been applied to some of the commands and sections on the home 
screen with regards to scenes 

Magics 27 Magics 26 

Create new part scene Create new part 

Create new platform scene Create new platform 

New mesh part scene New mesh part 

New BREP part scene New solid part 

Edit in Part Scene Edit Part 

Import Part Add Component/ Add Part 

 

To better differentiate these 3 different types of scenes that come with Magics, icons have 
been added to the different scene tabs: mesh part scene, solid (BREP) part scene or platform 
scene.  On top of that, an easy way to rename and close scenes is available now as well.      

    

Drag&drop of files on part scenes 

Beside the previously introduced options of dragging and dropping file on the home screen, 
platform scenes or on the tabs, Magics 27 now comes with the possibility to also drag and drop 
file(s) directly into BREP and mesh part scene(s).  This new functionality behaves as the 
‘import part’ function. 

 

Drag&drop of parts among platform scenes. 

Magics 27 introduces an easier way to move parts among the platform scenes with simply drag 
and drop highlighted parts to a platform scene tab.  
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Highlight the parts you want to move from the part list 

 

 

Drag and drop to the platform scene you want to move them to 

Grouping  

From Magics 27 onwards, grouping functionality is also available inside mesh part scenes to 
enhance data preparation workflow. User(s) can group, ungroup or remove parts from already 
created groups. 
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2 What’s new – working with BREP 

In Magics 26 BREP functionality was introduced. BREP, or Boundary Representation, is a 
way of representing 3D parts. STEP and CAD native file formats are examples of BREP files. 
In Magics 27 the BREP functionality has been extensively expanded with new editing 
operations, measurements, primitives, ... 

Working directly with BREPs can only be done in a BREP part scene, which can either be 
created from the home screen, or via import or drag&drop of a CAD part.   

Note: when importing (or drag&drop) a CAD part into a mesh part scene or platform scene it will be 
automatically converted to a mesh representation. 

2.1 New BREP functionality 

Delete face  

Magics 27 introduces the ‘Delete face’ tool allowing users to further enhance BREP editing 
workflows by deleting & healing BREP faces undesired for printing process. The tool can help 
to quickly defeature unprintable holes, fillets, chamfer etc.  

 

 

Before 

 

 

After 

 

Taper face 

Magics 27 comes with the ‘Taper face’ tool allowing users to taper a single or multiple faces of 
BREP model at a specific angle with respect to a reference plane. This powerful tool enhances 
flexibility of design optimization process and allows to reduce time of editing non-printable 
BREP faces. 

 

 

Before 

 

 

After 
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Cut or Punch  

Magics 27 comes with possibility to perform basic cut operations on BREP part(s) along 
active sections.  

 

 

 

 

Active section cut preview 

 

 

Cut result with clearance 

 

 

Measurement thickness 

Measurement toolpages have now been introduced in the BREP Part Preparation scene. With 
the introduction of the toolpages, now users will be able to perform different types of 
measurements on BREP entities such as Distance, Circle, Angle and thickness measurements. 
Through the toolpages as well, measurement stubs can be removed and set to hidden easily. 
 
Note: Currently it is only possible to pick points(s), line(s), circle(s) and plane(s) on BREP parts and 

sections.     
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Real measurement 

Add Real measurement function has now been enabled for BREP models. It works the same 
way as for Mesh parts. 

 

Bounding box measurements and Section info  

Bounding box measurement and section info are now also available in the BREP part scene. 

 

2.2 Improved BREP functionality 

Convert Scene to Mesh 

Now, it is possible to set the main conversion parameters for the BREP to Mesh conversion 
when performing Convert Scene to Mesh. The plane tolerance is the tolerance between the 
BREP model to the triangle faces in the mesh model while the angle tolerance is the angle 
deviation between the triangle in the resultant mesh model.  

 
Note: The default parameters are the default values used in Magics 26.0, hence for having similar 
outputs, you may use the default values.  

 

 

Match measurement mode for Rescale 

Match measurements mode in Rescale was enabled for BREP part(s) in Magics 27. 

 

Point and Line picker for Translate and Rotate tools for BREP parts  

‘Translate along the line’ and ‘Indicate point’ options are enabled for Translate and Rotate 
commands for BREP models. 
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BREP import enhancements 

1. Previously used parameters are now preserved in the BREP import dialog on 
subsequent executions.  

2. “Add file name to part name” parameter is now independent from the “Use original 
name” parameter. Hence, it is now possible to keep only the file name as the part name 
after importing BREP parts by checking on only the file name parameter as shown 
below.  

 

New BREP Primitives 

New primitive types such as torus, tube and tensile bar are added to the create BREP 
primitive dialog.  
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3 What’s new – loading, import & export 

3.1 New Project based on a Magics template file 

Magics 27 comes with the possibility to start a new project with a default set of scenes and 
parts based on a Magics project template file.  

 

For convenience, the default project template is pre-defined in settings and can be further 
customized according to user needs.  

3.2 Loading/saving files improvements 

Loading and saving project files 

Compared to Magics 26, when existing content of the target Magics session always stayed 
unmodified after opening *.magics files, Magics 27 comes with the extra option to load project 
files replacing the content of the active session.  ‘Load project’ command can be accessed 
from the home screen or from the File menu->Open->Load project or ‘Ctrl+L’ as default 
shortcut. 

Note 1: If a single Magics file is drag and dropped into the Home Screen, then the file will be loaded as 
a project automatically.  

Note 2: If a Magics file is listed in the Recent files list of the Home Screen, then clicking on the file will 
automatically load the file as a project while all other file formats will be opened automatically.  

 
Saving multiple parts in single file 

From Magics 27 onwards, the user can save multiple selected parts to one file. This option is 
available for *.magics, *.mgx, *.matamx, *.3mf, *.3D PDF and *.amf formats. Saving multiple 
virtual copies on the platform scene to a single file, will result in each part being split to an 
individual unique part before being saved to the file.  

 

Note: for 3D PDF format the option ‘save parts to one file’ replaced the former ‘As Assembly’ option. 
No changes in saving behavior were made compared to Magics 26. 

 

Loading Slice file formats through the Open command/flow 

It is now possible to open files with slices directly from the home screen or through the open 
command. If the file does not contain any platform information for the slices, then a New 
Platform dialog is shown the user so that the user can specify the desired platform to place the 
slices on.  
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Note: It is still possible to load slice files directly to an active platform through the Import command.  

For some formats such as SLC (“slc”) file format, if the necessary SLC to STL conversion 
license is available, then when loading these files the dialog to allow user to convert the slices 
to STL are also shown.  

 

Note: If the SLC to STL conversion license is available, it is also possible to add parts that are converted 
to STL directly from the Mesh part scene.  

 

New format for slicing: CLI (float) 

CLI (float) is a new slicing format option. It is possible to select the CLI (float) slicing format in 
the Slicer properties and on the “Export slice page of the Machine Properties. The option is 
available for both parts and supports.  
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The differences between the regular CLI format and CLI (float): 

• Regular CLI has a fixed precision with 16bit numbers with a resolution defined (2^16 = 
65536 px). It means that the maximum size of the platform that can be sliced using CLI 
can be calculated as follows: max_dimension = 65536 / resolution. Any higher value 
cannot be represented.  

• CLI (float) format uses 32bit floating numbers. For practical purposes, there is no 
resolution limitation. For higher numbers the precision of the numbers decreases. 
Theoretical resolution limit is 10^38 px.    

• as CLI (float) uses 4 bytes per number compared to 2 for cli short, the resulting sliced 
files are about 2 times bigger.  

• Based on the differences, CLI or CLI (float) format option may suit the user’s needs 
better depending on the platform size, expected precision, or resulting file size 
requirements.  

• If a circular platform has coordinates starting in the middle of the platform, then parts 
with negative coordinates can’t be sliced with CLI format. CLI (float) can be used for 
slicing instead.  

 

Importing Part to the scene optionally preserves transformation 

When importing parts from Materialise file formats such as .magics or .matamx, you can now 
specify if you want to load all copies with the individual transformation preserved to the current 
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scene. Since these advanced file formats can contain multiple copies of the same part, each 
with unique transformation, this option will allow you to load them into your current active scene 
if necessary. Even if your file only contains 1 part, you are advised to keep this parameter set 
to True, to ensure all transformation information is loaded correctly.  

 

 

 

4 What’s new – UI/UX improvements 

4.1 Working with Coordinate Systems 

WCS visualisation 

The World Coordinate System indicator can be visualized independently from a part presence 
in the scene. 

User Coordinate System in Mesh Part Scene 

It is now possible to create, modify and save custom user coordinate systems again in Magics, 
specifically in the Mesh part scenes. Each separate mesh part scene can have its own 
separate unique list of custom coordinate systems that can be activated and deactivated.  

 

Note: The command is only available through the search bar currently.  
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It is also now possible to load custom user coordinate systems from files with the extension 
“.ucs” into mesh part scenes to be able to add them to the list of custom coordinate systems.  

Several operations have been revalidated to work as expected for the custom coordinate 
systems.  

• Part(s) Import & Export 

• General transformations (Translate, Rotate, Rescale, Mirror)  

• Measurements 

• Primitive Creations 

• Section Views 

4.2 Lattice structures improvements 

3D representation of parametric lattice structures was improved in Magics 27 and from now 
onwards represents real thickness assigned to lattice beams accordingly. Pre-set color for 
lattices with non-positive thickness was set to red and can be changed anytime later in 
preferences manually. 

 

It is also now possible to toggle the thickness rendering of lattices between rendering with 
thickness and without thickness quickly with a toggle button in the View tab in the ribbon bar.  

 
 
 

4.3 New Mirror dialog with support for BREP part(s) 

A new Mirror dialog has been introduced to modernize the operation to improve the user 
experience for the operation. With this new dialog, the different methods to perform the Mirror 
operation are much more evident and self-explanatory.  

With this new dialog, the mouse picking modes is much easier to work with clear feedback to 
the user of their picking action. 



Materialise Magics 27.0 Release Notes 15 

Copyright 2023 Materialise N.V. – Release Notes 05/2023   

Materialise nv  I  Technologielaan 15  I  3001 Leuven  I  Belgium  I  info@materialise.com  I  materialise.com 

Note: Unlike previously the new mirror dialog is also updated to a non-modal dialog to keep in line with 
the general UI consistency.  

 

 

Along with the new dialog, now it is possible to perform Mirror on BREP parts as well. It is also 
possible to pick entities such as line(s) and planar faces on BREP parts also.  

 

4.4 Other 

Import Magics UI profile  

After installation, user can import both Magics Preferences and UI profile by pressing “Import” 
button when the below dialog pops up.   

 

 

Note: Only UI profiles from magics 26.0 or later can be imported into Magics 27.0 

 

Boolean naming improvements 

Possibility to assign custom names for Boolean result is added back. It’s now enabled for 
BREP and Mesh Parts. 
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Preserve English naming 

Naming for ‘Create’  

Magics 27 comes with possibility to always use English names when creating primitives 
regardless Magics localization setting.  

Naming for Build Jobs 

It is possible to set the default Build Job name to always be shown in English regardless of 
the Magics localization setting.  

 

Customize shortcuts 

Now users are allowed to assign shortcuts in a more efficient way on its own specific page in 
the Customize UI dialog. The shortcuts for different layouts can be easily assigned and aligned 
in this page. 

 

 

Minimize Magics Home Screen 

It is now possible to minimize the home screen with the minimize button in the title bar or the 
application item in the task bar quickly.  
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Modern Label Dialog 

Label dialog became more user-friendly with improved UI. 

 

 

Part context menu in scenes 

Part context menus are enhanced with ‘Translate’ and ‘Rotate’ commands in all available 
scenes. 

 

Part Fixing Info 

The ‘Autorefresh’ of part fixing info is by default OFF, to improve the performance when 
working within scenes, especially if there are lots of parts or large parts present.  A user can 
switch this ON again if desired. 

 

Top/Bottom plane  
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‘Indicate Plane’ mouse mode becomes a toggleable option and is activated upon launch of 
the command by default. If part selection needs to be changed, mode deactivation can also 
be done without re-opening the dialog. 

 

Part selection improvements in active scenes 

To reduce the number of accidental part deselection when working on a single part, it no longer 
is getting deselected when clicking on the empty space.  

Also, it’s possible to change selection state of a specific part quickly with CTRL+LMB click 
without affecting selection state of other parts. 

 

Remembering of fixing profile 

From Magics 27 onwards, selected Fixing Profile will be remembered across different Magics 
sessions. 

 

Improved default values for Triangle Reduction 

Default values for Triangle Reduction are updated to be less aggressive and better suitable 
for most data preparation cases. The new values are:  

Tolerance: 0.01mm 

Max angle: 1 degree 

Iteration: 5 

 

Open online support 

Next to contacting support directly through a support request, it is now also possible to first 
look for online support. 
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5 What’s new - Materialise Machine Manager integration 

Magics 27 offers the possibility to connect to the Materialise Machine Manager (MMM). This 
will allow users to create platforms for machines that are available on MMM, assign strategies 
that are defined on MMM and send the platform to MMM for processing with a build processor. 

5.1 Connection to MMM 

In the Magics settings, an entry is added where a user can establish the connection to MMM 
and provide credentials in order to get access to the machines and strategies as defined on 
MMM. 

 

5.2 Machine selection and platform visualization 

The different places in Magics where a machine can be selected (New Machine, Recently 
Used Machines, New Platform) will show an aggregated list that displays classical BPS 
machines, machine catalog machines, and machines available on MMM. Upon selection of an 
MMM machine, the platform will be visualized based on the machine properties as defined on 
MMM. Platforms of different types of machines (like BPS and machine catalog machines) can 
be opened next to each other. MMM is the central location where machine properties of 
machines that are available on MMM are managed. Modifying machine properties for these 
machines is no longer possible in the Machine Properties in Magics itself. 

5.3 Support generation profiles and machine related parameters saved  

Parameters available on the Part placement, Z compensation, Support generation mode, 
Support generation parameters, Materialise e-Stage support parameters, Export platform, 
Materialise e-Stage export pages in Machine properties will be saved to Machine Manager 
together with the machine. 

Support generation profiles are saved with the machine instance on Machine Manager server. 
Multiple users will have access to the same support generation profiles saved centrally with 
the machine instance. 

5.4 Strategy assignment 

For machines that are available on MMM and for which a platform is opened in Magics, a new 
toolpage is shown for strategy assignment. This toolpage allows the user to set global 
strategies for the whole platform and to set overrides of part strategies for parts and supports. 
Default preferred strategies, as selected by the user in MMM, will be shown with a star in the 
list of global strategies in Magics.  



Materialise Magics 27.0 Release Notes 20 

Copyright 2023 Materialise N.V. – Release Notes 05/2023   

Materialise nv  I  Technologielaan 15  I  3001 Leuven  I  Belgium  I  info@materialise.com  I  materialise.com 

 

 

"Reset to defaults" button will reset selections of the strategies to the ones marked "Set as 
default preferred" on Machine Manager. 

5.5 Sending for processing 

When a platform is created for an MMM machine, a ribbon is displayed in Magics for that 
machine. On this ribbon a build button is present that will enable the user to send the created 
platform with the parts, including the assigned strategies, to MMM for processing with a build 
processor. The results of the processing can be accessed from MMM. 

With a successful upload and creation of a processing job on the Machine Manager, a 
confirmation message will be prompted in Magics: 

 

"Open job list" button will redirect to the Job list page on Machine Manager portal, where 
progress of the processing can be checked. 
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6 What’s new - CO-AM Integration 

Magics 26.1 already introduced brand new capabilities of using Magics with the CO-AM 
software platform. Users can open ordered parts from CO-AM, use the full part preparation 
capabilities of Magics and then save ready parts back to CO-AM order to maintain traceability 
and auditability.  

In Magics 27, machine level integration with CO-AM is introduced. Users can load a platform 
with the machine parameters and parts taken from their CO-AM environment, use Magics build 
preparation tools, and then save the resulting platform back to CO-AM.  

 

6.1 CO-AM integration on part level  

Login with CO-AM account 

To start working with CO-AM parts in Magics, user should go to CO-AM environment on the 
web, login, and initiate opening a part from CO-AM in Magics. Until then, the Magics instance 
will show a message in the Settings that it is not connected to any CO-AM accounts.  

 

Using Magics with multiple CO-AM accounts 

If the user is working with multiple CO-AM accounts on the same or different servers, when 
user opens parts from the different accounts, then Magics will open a new instance for each 
account. Magics will open parts from the same account in the same instance.  

 

6.2 CO-AM Integration on machine level 

In CO-AM interface there are multiple pages that give the option to open a platform in Magics. 

• Locate "Open in Magics" button in CO-AM for platforms on the Machine platforms list, 
in created jobs etc..  

• Select the platform and click "Open in Magics".  

• If there is one or more Magics instances already opened, then Magics will show a dialog 
for selecting an instance and scene for the platform opening. 

The platform with the exact parameters selected in CO-AM will load in Magics together with 
the selected parts.  
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Users can view the saved platforms on the Machine platforms page.  

CO-AM platforms can be distinguished from other platforms in the same instance of Magics by 
the blue color of the icon in the platform scene tabs (i.e."EOS M290 -1" on the picture below). 

 

 

6.3 Saving parts and platforms to CO-AM 

When Magics is connected to a CO-AM account, then Save selected part(s) to CO-AM and 
Save Platform to CO-AM buttons appear in Magics interface:  

• in the quick access bar  

• in the part context menu (only for parts) 

• under File -> Save menu 
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6.4 Supports on CO-AM platforms 

Platforms with supports can be saved to CO-AM as usual, but in the current version of Magics 
supports will be converted to stl supports during saving, so after reopening a saved platform 
with supports from CO-AM the supports cannot be modified, and need to be regenerated again 
if necessary. 

6.5 Export-controlled parts 

CO-AM as a platform supports workflows with exported-controlled parts. Export-controlled 
parts are the parts production of which falls under the International Traffic in Arms Regulations 
(ITAR).  

Magics is aware when ITAR parts are opened from CO-AM. If an ITAR part is being added to 
a CO-AM platform without any other ITAR parts, then Magics will notify the user about it in a 
message. 

If a non-ITAR part is being added to a platform with ITAR parts, Magics will also notify about 
it. 

6.6 CO-AM Machine Properties 

Most Machine Properties for machines loaded from the CO-AM environment are saved to 
CO-AM and will be applied to the platforms using the machine each time a platform is 
opened. The first time a machine is opened from CO-AM in Magics, the default parameters 
will be applied.  

If multiple platform scenes are opened with the same machine, when the parameters are 
changed for one of the platform scenes, then the same parameters will be applied to all 
platform scenes alike.   
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7 Bugfixes 

• User interface and display fixes: 

o A bug that caused issues with the visualization of the Wall Thickness Analysis 
result, in case textures were present, has been resolved.  

o The border of the Magics application window was missing if Magics was not on 
full screen.  This has been restored. 

o Previously if a part has textures, the textures will be blocking the Wall Thickness 
Analysis gradient mark, now the textures are automatically hidden while the 
gradient thickness is shown on the part.  

o Wall Thickness Analysis gradient color mask can also follow the Part shading 
mode to ensure the part wireframe can be shown along with the gradient 
coloring.  

o When parts are grouped in Magics, then the number of parts in the part list is 
correctly displayed and the grouped parts are counted 

o 'Range by part Z-height' option fixed to work with slice stacks when the 
'Translate to default part Z position' is TRUE in “Automatic placement” 

• Functionality fixes: 

o A bug where changes in Support Generation parameters were applied across 
all profiles instead of only in the profile where the changes were made, was 
fixed. 

o A bug that prevented creating platforms for SLM machines, was fixed. 

o Magics shortcut is now added for all local users after silent installation of Magics 
via administrator account. 

o A crash that prevented exporting parts that contained UNICODE characters to 
certain ASCII files has been resolved. 

o RapidFit info that is present in *.magics files will be loaded. 

o A crash when trying to transfer support on parts that are in compact mode (e.g. 
when coming from Streamics) has been fixed. 

o An issue where the 'A' key could not be used for customization of any 
commands has been resolved. 

o An issue where saving files to MGX file with self-extracting option was not 
working as intended is now fixed.  

o An issue with some DXF file not being able to be used to generate drawing-
based labelling has been fixed. Magics should be able to ensure that separate 
polyline segments are interpreted properly to identify closed contours more 
accurately.  

o 3mf file saving now works in 64bit format, removing the former data size limit 
upon export 

• Slicing-related fixes: 

o Fixed TYPE value in the .slc file for parts to be PART instead of WEB. This used 
to cause the issue of sliced parts to be recognized as supports by some printers 
(i.e. Stratasys Neo 450s and 800).  
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o Fixed the issue with CLI slices that could not be loaded on Digital Metal binder-
jet machines  

o An issue with the error "CLI format is NOT compatible with this resolution. Part 
will not be sliced" has been fixed 

o Slicing speed improved compared to Magics 25 and 26.  

• Streamics compatibility: 

o Parts are correctly opened in the Part scene instead of Modeler scene.  

o Quantity of parts in Batch Duplicate dialog matches the number in the 
Streamics order.  

o Fixed loading time of Materialise Software ribbon and Streamics commands 
after launching Magics.    
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8 Known Issues 

8.1 Import & Export 

• In certain cases, no warning is shown asking the user to save a BREP part/ BREP part 
scene 

• Select orientation: when clicking close, all subsequent part loading is cancelled 
regardless of "Apply to all" state. 

• Part selection can not be saved to matamx files 

• Importing of files via MatConvert is not possible if the file path is longer than 256 
characters. (MatConvert known issue) 

• In rare cases, importing part on the platform can block ‘Select Orientation’ dialog 
resulting in an infinite Magics hang. As workaround, the ‘Select Orientation’ dialog 
should be disabled in Magics settings. 

8.2 CAD-based workflow 

• Import /Export  

o Unicode characters are not supported when exporting a BREP model to STEP 

• CAD functions for BREPs 

o In specific cases, some edges causing failure of Fillet operation are not 
rendered in error state 

• Concept of colours for BREP models is not fully supported yet, only face colours are 
being preserved upon import of a part. 

• File preview of Magics files containing BREP models is not shown. 

• In some cases, a BREP Tensile bar primitive might have wrong orientation upon 
creation that can be adjusted manually afterwards.  

• In some cases, filleting a convergent body might result in error. 

8.3 Handling color information 

• Magics is not considering the concept of sRGB and assuming all color info to be linear 
RGB.  The most noticeable issues with this are: 

o Magics is unable to display the full color depth as intended with sRGB.  Color 
information will look a bit more 'faded', less rich in color 

o when importing a file with sRGB colors, Magics will display these RGB values 
as if they were linear RGB values 

o Magics does not convert from linear to sRGB, nor from sRGB to linear.  Thus 
when importing a file with linear RGB and exporting to a file with sRGB, the 
export will contain the wrong RGB values (and vice versa, from sRGB to linear 
RGB). 

o in Magics it is possible to color parts and vertices, which is done in linear RGB.  
So when importing a file with sRGB colors, adding colors in Magics will result 
in having a part with partially sRGB and partially linear RGB colors. 

o As a work-around, to avoid conversion issue, it is advised to import and export 
colored parts using the same data format.  As Magics is not changing the RGB 
values, this ensures no loss of data.  In case of sRGB data format, it does mean 
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that the rendering in Magics will not be 100% accurate (color information will 
look a bit more 'faded', less rich in color) 

8.4 Support Generation 

• Disabling the showing of perforations in supports can lead to supports overlapping with 
a part. 

• Situations where a part that has a surface that is (partially) closer than 1mm to the 
platform and that is supported by trees with angling applied, can lead to incorrect tree 
supports being generated. 

• The ‘Trim supports on other parts’ functionality might not work as expected when: 

o used in combination with post-processing. 

o used with tree supports and a part intersecting the tree supports is moved. 

o moving the part on which support structures of another part rests. 

• When the creation of manual tree support is interrupted before the tree support is 
generated, an empty support surface can remain. This support surface can be removed 
manually. 

• In some cases where block support is used, the state of the parameter ‘GENERAL > 
Critical points > Local minima support > Adjust hatching’ can influence the state of the 
parameter ‘Add point support > Align with hatching’. 

• Modifying a support surface (e.g., adding or removing triangles) with Tree supports and 
using ‘regenerate’ button will not update the Tree supports with the modified surface. 
Changing to and from another support type or modifying a parameter will update the 
Tree supports with the modified surface. 

• Gusset supports may not be properly trimmed in certain cases. 

• In some cases, manually added supports are transferred with wrong position. 

• Thickened non-solid support may intersect or detach from the part or create open 
contours. 

• Manually created surfaces that contain overlapping projections may result in support 
structures being generated above the part. 

• Applying 2D Cut on a Block support with thickened border may result in alteration of 
the geometry on the border corners. 

• No-support zones on marked Structures (for some geometries of Structures) are 
ignored during e-stage generation. 

 

8.5 Machine Manager integration 

• Gas flow angle defined on Machine Manager portal will show correct direction of the 
Gas flow on platform scenes only for values: 0, 90,180, 270 or 360 degrees. 

• In rare cases, for rectangular platforms with rounded corners defined on Machine 
Manager - the platform won’t be visualized in Magics. 

• Field overlaps that aren’t connected to two opposite sides of the platform won’t be 
visualized on the platform scene in Magics. 
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8.6 CO-AM integration 

• CO-AM part is considered as modified after Translate + Copy operation 

• Undo/Redo operations don’t change the state of "Save part to CO-AM" button 

• Operations recorded for a specific part revision in CO-AM can include some positioning 
and supports changes from other parts 

 

8.7 Other 

• Installer 

o After uninstallation, the uninstalled Magics version is still available in the 
Windows ‘open with’ list 

o No desktop icon/shortcut is created in case Magics is not installed in the default 
destination folder 

• Titles of items in History are all called Database. 

• Some of the default shortcuts and context menu are still missing. 

• Rapidfit command is not present in default UI profile however it can be launched from 
the quick search in the platform layout. 

• In some cases, for Top/Bottom plane operation, ‘Indicate plane’ button should be re-
activated to make it work after changing part selection.    

• The name of original part is not restored after Undo of multiple operations. 

• The zone legend is missing in the ‘Check Slices Distribution’ graph 

• The point legend is missing in the ‘Compare Points’ graph under Simulation 

• Upon importing preferences from a another Magics installation (either via import 
settings, or upon launching a newly installed Magics version), Magics will also update 
the MatConvert version settings.  This could cause Magics to use an older MatConvert 
that does not contain the latest compatibility or functionality needed to fully use Magics.  
For Magics 27 it is recommended to use MatConvert 10.4 or higher.  This can be set 
in Settings > Modules > MatConvert 
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9 Compatibility  

9.1 Bundled components 

Product Versions 

Magics 27.0.0.934 

MatConvert  10.4.0.10 

Build Process System  3.3.1 (*) 

MatLicensing 7.4.4.0 

 

9.2 Compatibility with other Materialise product releases (**) 

Product Versions 
Streamics 8.3 

Robot 8.3 

3-matic 17.0 

Simulation module 3.0.3 

e-Stage 7.3 

MatConvert 10.4 

Build Processor System  3.3.1 (*) 

CO-AM  release 100 

CO-AM Machine Manager 1.1.69 

 
For compatibility with specific Build Processors, please refer to the release notes of BPS and/or the 
specific Build Processor. 

 

* Magics is fully compatible with older versions of the Build Process System (BPS) as well. The bundled 
BPS will only be installed/upgraded in case there is no installation yet of BPS, or in case the current 
BPS is not compatible with Magics 27 (BPS version lower than 1.7.16) 

** Compatibility with newer versions of these products is expected unless explicitly mentioned in the 
respective release notes, and is nevertheless limited to existing functionality only.  Any new functionality 
in these products cannot be guaranteed to be compatible with Magics 27.   
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9.3 Compatibility with other CAD packages 

Magics 27.0 comes with MatConvert 10.4, which supports the below CAD formats.  The bold 
formats have been updated compared to MatConvert 10.1 (which was bundled with Magics 
26.02).  

MatConvert is being released on a quarterly base, to ensure compatibility with the latest CAD 
formats, and can be downloaded and installed separately. 

Please note that the ‘all imports’ license is needed for all these CAD formats, except for 
importing STEP files. 

Via ‘Magics RP’ base license 

STEP 

*.stp, *.step 

AP203 (E1, E2), AP214 (up to E3), AP242 (E1,E2, 
E3)  

VRML *.wrl,  *.vrml, *.x3dv 1.0 and VRML 97, X3D 3.3 

Via ‘all imports’ module 

IGES *.igs, *.iges Version 5.3  

ACIS SAT *.sat Up to 2021 1.0 

JT *.jt 6.4 to 10.7 

Rhino *.3dm Rhino 7.11 

CATIA 5 *.CATPart, *.CATProduct R10 to V5-6R2022 (R32) 

CATIA 6 *.3dxml R2010x to R2023x 

Pro/Engineer *.prt,  *.asm 2000i to Creo 9.0 

Siemens NX  *.prt 15 to NX 2206 Series 

Parasolid *.x_t, *.x_b V7 to V35 

SketchUp *.skp SketchUp 2022 

Autodesk 
Inventor 

*.ipt 9 to 2023 

Revit *.rvt 2011 to 2022 

Solidworks *.sldprt, *.sldasm 2006 to 2023 

Solid Edge *.par 10 to 2023 
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10 System Requirements 

 

Hardware* Software 

 

CPU 

o Intel Core i7 
o AMD Phenom II X4/ X6 at 3.0 GHz 

or higher with SSE2 technology 

 

Memory 

o 16 GB RAM or higher 

 

Free Disk Space 

o Win 64-bit system 
o 2GB of free disk space 

 

Display 

o 1920 x 1080 resolution or higher 
o 32-bit color depth (True color) 
o 4K monitors are not actively 

supported 

 

Video Card 

o NVIDIA GeForce GTX 1060’ or AMD 
Radeon RX 480 or better 

o DirectX 11 compatible video card 
o At least 4 GB of memory 
o At least a memory interface width of 

192-bit (256-bit is recommended) 
 

 

Materialise Magics 27 is only supported 
on Windows 64-bit**: 

o Windows 11 
o Windows 10 version 21H1 or later 

 

Materialise Magics 27 is recommended 
on: 

o Windows Pro edition 
o Windows Enterprise edition 

  

Materialise Magics 27 is not supported on: 

o Windows 8.1 or earlier 
o Windows Server Editions 
o Virtualization systems such as 

VMWare 

 

Materialise Magics does not run natively 
on Mac OS X, Linux, or any other 
operating system not listed above. 

 

.NET  4.6 or later or a working internet 
connection during the installation is 
required. 

 

* These hardware requirements are considered minimal for professional usage, but depending on the 
expected use cases (mainly influenced by project size, amount of triangles and number of parts) it is 
recommended to invest in appropriate hardware (more memory, larger disk size, ... ).  More info can 
also be found on: https://help.materialise.com/93151-tips-and-tricks/magics:-performance  

** Materialise Software will discontinue supporting an operating system, or a specific version of an 
operating system, from the moment that the OS vendor discontinues support. 

 

https://help.materialise.com/93151-tips-and-tricks/magics:-performance
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11 Contact Information 

For more information, check out our website: materialise.com/software/magics/ 

For technical support, please check http://help.materialise.com/ or contact one of our 
Customer Support teams: 

 

 

Europe (Headquarters) 

Technologielaan 15  
3001 Leuven 
Belgium 

Phone +32 16 39 66 11 
software.support@materialise.be 

USA & Canada 

44650 Helm Court 
Plymouth, MI 48170 
USA 

Phone: +1 734 259 6445 
Phone (toll-free): +1 888 662 5057 
software.support@materialise.com 

United Kingdom 

AMP Technology Centre 
Advanced Manufacturing Park 
Brunel Way, Catcliffe 
Sheffield, S60 5WG 

Phone +44 1143 997 845 
software.support@materialise.co.uk 

Germany 

Friedrichshafener Str. 3 
82205 Gilching 
Germany 

Phone: + 49 8105 77 859 20 
software.support@materialise.de 

China 

Baoshan District 
Hutai Road 2999 
1F Building  no 1 
Shanghai 200444 
P.R.China 

Phone  +86 21 583 124 06 
software.support@materialise.com.cn 

Japan 

Yokohama Portside Bldg. 2F  
Sakae-cho 8-1  
Kanagawa-ku, Yokohama  

Phone +81 45 440 4591  
support@materialise.co.jp 

Asia – Pacific  

Unit 5-01, Menara OBYU 
No. 4, Jalan PJU 8/8A, Damansara 
Perdana 
47820 Petaling Jaya 
Selangor Darul Ehsan - Malaysia 

Phone: +603 7724 1415 
software.support@materialise.com.my 

 

http://www.materialise.com/en/software/magics
http://help.materialise.com/
mailto:software.support@materialise.be
mailto:software.support@materialise.com
mailto:software.support@materialise.co.uk
mailto:software.support@materialise.de
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